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Creating an XSEDE User Portal Account




Create a Portal Account at Any Time

XSEDE |USER PORTAL o e

Extreme Science and Engineering
enf

MY XSEDE RESOURCES DOCUMENTATION ALLOCATIONS TRAINING USER FORUMS HELP ABOUT

Summary  Allocations/Usage Accounts Jobs Profile Publications Tickets Change Password Add User Community Accounts SSH Terminal

Welcome to The XSEDE User Portal (XUP), the home on the web for XSEDE users! The XUP
provides XSEDE users access to view and manage their accounts and allocations, as well as

E nte r th e PO rtal find information about and access the XSEDE services and resources.

Here's a few of the things you can do here without even logging in
USER NAME

¥ov8a33d )

see XSEDE resource and service status
View user news and upcoming events

PASSWORD - : R
Find and register for training classes

Log in or create an account to get started!

m [] REMEMBER ME

CREATE ACCOUNT VERIFY ACCOUNT FORGOT PASSWORD

FORGOT USERNAME




Step 1- Request an Accoun

@ XSEDE User Portal | My XSEDE - Mozilla Firefox il —————— — N

File Edit View History Bookmarks Tools Help

’/\Z' a Jn- fivrxsede?.grgu—’; ny-xsede?’p_p_id= &p_p. fecy state=maximize 2w&p_p_col_it s 36 Ve ?:L' ]_L!
xI+

Please provide the following information to creste your User Portal account

ia Holiday Inn Statesboro-University Are... m XSEDE User Portal | My XSEDE

PERSONAL INFORMATION

FIRST NAME MIDDLE NAME LAST NAME

ORGANIZATION DEPARTMENT

DEGREE DEGREE FIELD OF STUDY

Choose one

POSITION

Choose one

ADDRESS

Yovea3ad ()

ZIPIPOSTAL CODE

COUNTRY STATE/PROVINCE

United States | |Choose one

PHONE

COUNTRY OF CITIZENSHIP

United States

CHOOSE A REGISTRATION KEY

You will use your registration key to identify yourself in the Verify Account step. Use only letters and numbers; maximum € characters

REGISTRATION KEY (THE CODE YOU CHOSE DURING THE CREATE ACCOUNT STEP)

cW e B | Hew

12/2/2013




Step 2 — Account Request Verification

@) XSEDE User Portal | My XSEDE - Mozilla Firefox il [ e —— E—— — )]

File Edit View History Bookmarks Tools Help

£ a ‘n f‘“xsedei.grg..;iw ny-xsede?p_p_id=58&p ew&p_p_col_

u'ﬁ Holiday Inn Statesboro-University Are... m XSEDE User Portal | My XSEDE x | +

Plesse provide the following information to create your User Portal account.

PERSONAL INFORMATION

FIRST NAME MIDDLE NAME LAST NAME

ORGANIZATION DEPARTMENT

DEGREE DEGREE FIELD OF STUDY

Choose one

POSITION

Choose one

ADDRESS

yovaa3zd &

ZIPIPOSTAL CODE

COUNTRY STATE/IPROVINCE
United States ¥ | |Choose one

PHONE

COUNTRY OF CITIZENSHIP
United States [w

CHOOSE A REGISTRATION KEY

You will use your registration key to identify yourself in the Verify Account step. Use only letters and numbers; maximum € characters

REGISTRATION KEY (THE CODE YOU CHOSE DURING THE CREATE ACCOUNT STEP)

=
. 829 PM
mo ® 12/2/2013



Why a User Portal?

Updated Account Information
Access to Allocated Resources

— The portal provides a single location from which
to access XSEDE resources.

Easy Training and Event Registration
XSEDE News

Interfaces for data management

Access to Help




iPod 2 2:37 PM .

Also avalilable:

Home LOGIN

Mobile User Portal

XS EDE | vwsueronra
Extreme Science and Engineering
Discovery Environ ent

Ao i caments »  https://mobile.xsede.org
User News >
System Status >
Training >
Help >
More >




Requesting Access to XSEDE Resources




XSEDE Allocations

» XSEDE allocates access/time on powerful, valuable

systems providing different capabilities
— HPC

— High throughput computing

— Remote visualization

— Data storage

— Etc.

e Single Sign-On allows you to use just one username
and password (your User Portal one). You will be
recognized by all XSEDE services on which you have
an account, without having to enter your login
information again for each resource.




Resource Access Options

* Apply for an XSEDE Allocation

* Request to be added to an existing allocation
e Contact your local campus champion

* Use a Science Gateway




Eligibility

* Principal investigator (Pl) must be a researcher or
educator at a U.S.-based institution, including federal
research labs or commercial organizations.

* A postdoctoral researcher is eligible to serve as PI.

* A qualified advisor may apply for an allocation for his
or her class, but a high school, undergraduate or
graduate student may not be a PI.




Overview: Startup/Education Requests

 Requires only CV and abstract
 Reviewed by a XSEDE Staff (Startup Allocations Committee)
* 2 weeks from submission to award availability

* For code development / performance evalualtion/ small-scaling
computations / classroom & training instruction

Requests/Allocations
Reviewed: Anytime
Awards begin: ~ 2 weeks after submission




Limits Per Resource

Resource name Startup allocation limit (SUs)
Gordon ION 0
Kraken-XT5 200000
Mason 0
Lonestar4 50000
Keeneland-KIDS 0
Gordon Compute Cluster 100000
Trestles 50000
Quarry 1
Stampede 100000
Blacklight 30000

Keeneland 10000




Overview:. Research Request

 Web forms: Investigator, Grants, Resource Request,...
* Requires a written “proposal” (pdf upload)
 Reviewed by experts in same Field of Science

3 months from deadline to award availability

* For Research Projects

Proposals/Allocations

Limit: “Unlimited”
Reviewed: Quarterly
Deadlines: 15t of October, Jan., April, July

Awards begin: 1t of January, April, July, October




The Awards

* One per Pl (generally)
e Variable duration

* Unused SUs are forfeited at the
end of an award period (Can
reguest extensions)

* Supplemental Requests

* Annual Progress report required
for renewal requests.

e Add users to an allocation via
XSEDE User Portal




Research Allocation Proposal Outline

Research Objectives
. Codes and methods to be used

II. Computational plan
V. Justification for SUs (TB) requested
V. Additional considerations

Note: Sections Ill and 1V are often integrated.




Preparing a Request

* |dentifying Resource(s)
— System environment
— Software availability

* Information Sources
— User Guides
— User Forums
— SU Converter
— Software Search
— Help Question (Campus Champion or via Portal)




Stampede

User Guide

Debuting Intel's new innovative MIC technology on a massive scale, TACC's Stampede
system commenced production in January, 2013.

Blacklight

User Guide

Blacklight is a 3Gl shared memory system intended for applications that require a large
shared memory for computational tasks.

Gordon

User Guide

Gordon is a unique, a flash-based supercomputer designed for data-intensive
applications.

Keeneland

User Guide

Keeneland is a balanced hybrid CPUIGPGPU system for use with codes that can take
advantage of accelerator performance. Keeneland has over 200 nodes with 3 GPUs per
node making it an excellent resource for scaling highly parallel codes. Applications
from scientific domains such as materials, combustion, molecular dynamics, and
astrophysics have seen substantial perfformance increases on Keeneland.

Kraken

User Guide

The Kraken system is a Cray XT5 system with compute nodes interconnected with
SeaStar, a 3D torus. Kraken is intended for highly scalable parallel applications.

Lonestar

User Guide

Lonestar, a Dell Linux Cluster, is a powerful, multi-use cyberinfrastructure HPC and
remaote visualization resource. Lonestar is intended primarily for parallel applications
scalable to thousands of cores. Mormal batch queues will enable users to run
simulations up to 24 hours. Lonestar also provides access to large memaory nodes,
and nodes containing NVIDIA GPLU's, giving users access to high-throughput computing
and remote visualization capabilities respectively.

Mason

User Guide

Mason at Indiana University is a large memory computer cluster configured to support
data-intensive, high-performance computing tasks using genome assembly software.

Trestles

User Guide

Trestles employs flash-based memory and is designed for modest-scale research
providing wery fast turnaround time. It is intended for moderately scalable parallel
applications with an emphasis on improving productivity for a broad spectrum of users.
Trestles is ideal for applications with fast local /O requirements that can benefit from
the flash memory available on each compute node.

Xxsede.org

Resources




Extended Collaborative Support Service

e Can solicit ECS support for help:

* Porting applications to new resources

* Providing help for portal and gateway development
* Implementing algorithmic enhancements

* Implementing parallel math libraries

* Improving scalability of codes to higher processor
counts

* Optimizing codes to efficiently utilize specific resources

e Assisting with visualization, workflow, data analysis,
and data transfer




Using Your Allocation




My XSEDE: Allocations/Usage

When the allocation is active it will show in the Portal, MyXSEDE,
Allocations/Usage tab:

USER PORTAL

HOME MY XSEDE RESOURCES DOCUMENTATION ALLOCATIONS TRAINING CONSULTING USER FORUMS

Allocations’Usage Accounts My Jobs Profile Tidkets Registered DNs Change Portal Password Add/Remove User Community Accounts SSH Terminal

Projects SHOW INACTIVE PROJECTS | SHOW EXPIRED ALLOCATIONS

TG GIG User Services

Project Pl
Charge No.:

‘ RESOURCE SUS AWARDED SUS REMAINING % REMAINING MY USAGE (SU) START DATE END DATE ALLOC.TYPE STATE

taff.teragrid 400,000 149,041 2010-06-02 2011-10-02 renewal active

W
v

Allocations for Supplements, Advances and Transfers appear in the portal before they appear in the accounting records at TG sites. Please allow 24 hours
after you receive an award notification for the allocation updates to appear in the accounting records of the TG sites.




Make sure

SSO via User Portal you are
logged into

MY XSEDE RESOURCES DOCUMENTATION ALLOCATIONS TRAINING CONSULTING USER FORUMS the XSED E

‘M
Search: ® GO to y

" XSEDE’ tab
RESOURCE NAME LOGIN NAME INSTITUTION USERNAME CONMNECT

Athena athena-gsi.nics.utk.edu NICS no account Y GO to the
Big Red login.bigred.iuteragrid.org u Lagin ‘ACCOU nts’

Allocations/U=age | Accounts My Jobs Profile Tickets Registered DNe Change Portal Password Add/Remove User Community Accounts  SSH Terminal

Blacklight blacklight. psc.teragrid.org PSC Lagin .

Condor tg-condor.purdueteragrid.org Purdue Lagin Iln k

Dash dash.sdsc.teragrid.org SDsC Login ® Resources
Ember login-emberncsateragrid.org MNCSA Lagin

Frost tg-login frost. ncar.teragrid.org MNCAR Lagin you have .
Kraken kraken-gsi.nics.utk.edu MWICS Login acceSS to WI”
Lincoln lincoln.ncsa.uiuc.edu MNCSA Login be |ndlcat6d
Lonestar lonestar.taccteragrid.org TACC Lagin by a ‘Iogln’

Longhom tg-login longhaorn.tacc.teragrid.org TACC Lagin Ilnk

MSTG tg-login.ornl teragrid.org ORML Login

Pople tg-login.pople.psc.teragrid.org PSC Login ) C“Ck On the
Queen Bee gueenbee loni-lsu.teragrid.org LONI Login ‘Iogln’ Ilnk Of
Ranger tg-login.ranger.tacc.teragrid.org TACC Login th

Spur tg-login.spur.tacc.teragrid.org TACC Login e resource

| tg-steele purdue teragrid.org Purdue Lagin yOU WOUId
Trestles trestles.sdsc.edu sSDSC Login Ilke to Iogln to

St

m
m
[1¢]




Accessing Resources: Direct Access

e SSO is the default method.

 However, if you choose direct access:

you’ll need to request the direct access password for
the machine (by submitting a ticket).

— Use a secure shell (ssh) client.

— From Linux or Mac terminal window:
e ssh —| <username> <machinename>
 E.g.: ssh—| username ranger.tacc.utexas.edu
— From Windows:
 Download one of many ssh clients
* Free ones include “putty”
* Most campuses have a site license for a fancier one.




File transfers between XSEDE resources
or

Between your laptop and an XSEDE resource




TRANSFER CONS
METHOD

PORTAL Easy to use, single sign-on  Basic/beginner usage
via user portal, desktop
GRAPHICAL download available

USER INTERFACE  Globus Online  Easy to use web interface, Basic/beginner usage
can use Portal (SSO),
desktop download

available
Globus-url- Advanced syntax available Advanced knowledge
copy for scripting, can use required for
uberftp XSEDE single sign on, authentication and
handles large and small scripting capabilities
COMMAND LINE files
WVERESCE scp Easy to use Must use local
sftp username and

password, meant for
small files < 2GB

.. \/
EXSEL




File Transfers: Small (< 2 GB) Files

e To transfer small files between XSEDE Resources and/or your own
workstation you can:

e scp or sftp from the Unix command line. Easy to use. Provides poor

performance for very large files. Requires local username and
password.

e From Linux or Mac, you can run these commands directly from the
terminal.

e From Windows, use your ssh client to do this (putty has free downloads
for these tools, too! — just Google “putty sftp”).

These are easy to use and secure, but provide poor performance for large
files.




File Transfer: User Portal File Manager

URCES DOCUMENTATION ALLOCATIONS USER FOR

Resource Moniter Scheduled Downtimes  File Manager Queue Prediction Remote Visualization Science Gateways Data Collections

The XSEDE File Management Service enables you to use a GSl-enabled file browsing applet to view and manage your files within and across multiple
XSEDE systems automatically from the convenience of the user portal using a simple drag-and-drop interface. The java-based applet can sign you int
all your hpc, storage, viz and XSEDE Share accounts with a single click. You can also access your Amazon 53 account and add other gsissh-enabled
resources through a simple interface. The XSEDE File Management Service applet requires Java Runtime Environment (JRE) Java 1.6 JRE or higher
installed. It works best in IE 7+, Firefox 3.5+, or Safari 5+

The service is also available as a desktop application. You can download the executable file here. To find out more about the other comprehensive file
management services in the XSEDE, such as XSEDE Share, your Virtual File Space, and the Mobile File Manager check out the XSEDE data
management info page.

NOTE: Opening the applet for the first time will tske s few moments while the libraries load and you will need to accept the security messages before the applet starts.

To open the sessicn in 8 new window, go to File -> Open in new window. To run the applet as a desktop application, download the exscutable hers.

Log Iinto the
XSEDE User
Portal

*Select
“Resources”
tab

*Select “File
Manager” tab

* (now wait
for Java
Applet to
load)




portal.xsede.org—>Resources - File Manager

(FM  File View Help CIle on the X
@ Please select a resource Lij Please select a resource (XSEDE |OgO) to ||St a”
' : ' -~ machines. This includes:

@ N 40 Ff W0 O Dl @ N & o W 0O D |l
Local Local
file:f{127.0.0.1 — file:f/127.0.0.1 | | h.
[}
- U BigRed - U BigRed your Oca maC Ine
gridftp:/ /gridftp. bigred.iv.teragrid.org gridftp:/ /gridftp.bigred.iv.teragrid.org
LONI QueenBee - - LONI QueenBee
gridftp:/ /gridftp-gb.loni-Isu.teragrid.org gridftp:/ /aridftp-gb.loni-lsu.teragrid.org
- NCAR Frost | = NCAR Frost . XSEDE$Share
gridftp:/ /gridftp.frast.ncar.teragrid.org gridftp:/ [gridftp.frost.ncar.teragrid.org
-ap NCSA Ember mp NCSA Ember 2 G B Of SpaCe tO
gridftp:/ /gridftp-ember.ncsa.teragrid.org gridftp:/ /gridftp-ember.ncsa.teragrid.org
- NCSA Lincoln = NCSA Lincoln collaborate. Allows you to
gridftp:/ /gridftp-abe.ncsa.teragrid.org gridftp:/ /gridftp-abe.ncsa.teragrid.org
—| NCSA Mass Storage —i NCSA Mass Storage Share flles W|th your
i gridftp:/ /mss.ncsa.uiuc.edu — gridftp://mss.ncsa.uiuc.edu
- NICS Kraken Cray XT5 - NICS Kraken Cray XT5 collaborators
gridftp:/ /gridftp.kraken.nics.teragrid.org gridftp:/ /gridftp.kraken.nics.teragrid.org - - - - =
NICS Nautilus NICS Nautilus
- gridftp:/ /gridftp.nautilus.nics.teragrid.org - gridftp:/ /gridftp.nautilus.nics.teragrid.org xEEDE S EHARE
A H
ORNL Neutron Science TeraGrid Gateway - ORNL Neutron Science TeraGrid Gateway xshare:/| |IJ'I.|'Ir'I§|.EIII-rrEl|.'[IlEE.UIEEJS.EIjIJ
gridftp:/ /tg-gridftp.ornl.teragrid.corg gridftp:/ /tg-gridftp.ornl.teragrid.org
= PSC Blackliaht = PSC Blackliaht

 Click on the View’ tab and select “Show Transfers” to get information on
past and ongoing file transfers and speed.

» Drag files between resources.




Globus On-line

Fast, reliable service for high performance file transfer

High performance: Move terabytes of data in thousands of files
Automatic fault recovery - Across multiple security domains

Designed for researchers - Easy "fire and forget" file transfers

No client software installation - New features automatically available —

Consolidated support and troubleshooting - Works with existing
GridFTP servers

Ability to move files to any machine (even your laptop) with ease

Create a free account at www.globusonline.org ; For help: send email to

support@globusonline.org



http://www.globusonline.org

Need Help?




Reporting and Tracking Issues

* portal.xsede.org = Help
Submit ticket

* portal.xsede.org > My XSEDE - Tickets

— Submit ticket
— View past tickets (both open and closed)

* Can also email help@xsede.org or call
1-866-907-2383, at any hour (24/7)

* Your Campus Champion




Help: Submitting a ticket

HOME MY SED 4 ICES } UMENTATION ALLOCATIONS TRAINING { SULTING USER FORUMS

Help Desk  Security Incident

The XSEDE Help Desk providez a =single =ource of as=istance and rezolution for any XSEDE-related problems. Thiz includes providing useful answers
regarding accounts, access, and running on XSEDE resources. In addition, the XSEDE Help Desk is used to report bugs experienced while using XSEDE
resources, the XSEDE web site, and the User Portal

To reach the XSEDE Help Desk pleaze submit vour request via this form or 2end email to help@xsede org. The help desk uzes the XSEDE Ticketing Syster
(XT3} and will as=ign your email or form submission to a ticket. You will receive auto-notification back that lets you know your email has been received, £
provides you with a ticket number for reference. “ou can aleo reach the XSEDE Help Desk by phone at 1-865-907-2383, at any hour.

For feedback specific to the XSEDE User Portal including enhancements, suggestionz, and feature requestz, pleaze submit your comments and suggestion
via the Feedback form.

Note: All fieldz are reguired unless otherwize specified.

Select Category w
Site: (optiona Select Site | w

. (optiona Select Priority |

SUBMIT INSULTING TIC

Preferred
method:

Ensures all
relevant
detalls are
provided for
quick
routing




More “helpful” resources

xsede.org—> User Services
e Resources available at each Service Provider

* User Guides describing memory, number of CPUs, file
systems, etc.

e Storage facilities
 Software (Comprehensive Search)
* Training: portal.xsede.org = Training

* Course Calendar
* On-line training

 Get face-to-face help from XSEDE experts at your institution;
contact your local Campus Champions.

 Extended Collaborative Support (formerly known as
Advanced User Support (AUSS))

ek .




Extreme Science and Engineering
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